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READ CAREFULLY BEFORE USING

Canon Software License Agreement
IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM IN THIS
BOX.  BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREE-
MENT.
This is a license agreement (the “Agreement”) between you and Canon Inc. (“Canon”).
IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT USE
THE SOFTWARE PROGRAM ON THE CD-ROM (INCLUDING ALL SOUND AND IMAGE DATA) AND
THE USER MANUAL IN THIS BOX (COLLECTIVELY, THE “SOFTWARE”) AND PROMPTLY RETURN
THE SOFTWARE TO YOUR POINT OF PURCHASE FOR A REFUND.
In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions of this
Agreement.
1. LICENSE:  Canon grants you the personal, non-exclusive right to use the SOFTWARE only on a single computer.

You may physically transfer the SOFTWARE from one computer to another provided that the SOFTWARE is used
on only one computer at a time.  You shall not install or use the SOFTWARE on a network, multiple CPU, multiple
site arrangement, or any other hardware configuration where the SOFTWARE is accessible to more than one CPU
or to more than one user.
With respect to the sound and image data (“Data”) contained in the Software, which are to be downloaded to the
applicable Canon digital camera product, Canon grants you a personal, non-exclusive license to use the Data on a
single Canon digital camera product only.
YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE, ALTER,
MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART, EXCEPT AS
EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY:  You may make one copy of the SOFTWARE solely for back-up purposes, or copy the
SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer and retain the original for back-
up purposes.  Any other copying of the SOFTWARE is a violation of this Agreement.  You must reproduce and
include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES:  Neither Canon, nor its subsidiaries, dealers or distributors will be responsible for
providing maintenance or support for use of the SOFTWARE.  No updates, fixes or support will be made available
for the SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY:  It is your responsibility to choose, maintain and
match the hardware and software components of your computer system.  Thus Canon does not guarantee
uninterrupted service or correction of errors or that the functions or performance of the SOFTWARE will meet your
requirements.  THE SOFTWARE IS LICENSED ON AN “AS IS” BASIS AND WITHOUT WARRANTY OR
CONDITION OF ANY KIND. The CD-ROM storing the SOFTWARE is warranted only against defective material
under normal use for a period of ninety (90) days after purchase from an authorized Canon dealer as evidenced by
your sales receipt. Your sole remedy for a defective CD-ROM shall be replacement of the same without charge
when returned by you at your expense to your point of purchase and proven to be defective upon inspection.  The
Replacement CD-ROM will be warranted for the remainder of the original ninety (90) day warranty period of the
defective CD-ROM.  The limited warranty does not apply if the failure of the CD-ROM resulted from accident,
abuse or misapplication of the SOFTWARE and shall not extend to anyone other than the original user of the
SOFTWARE.
EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S SUBSIDIAR-
IES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, OR CONDITIONS, EXPRESS
OR IMPLIED, INCLUDING ANY WARRANTY OR CONDITION OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.
NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION,
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF PROFITS,
EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE SOFTWARE
OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS SHALL
HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT BROUGHT BY A
THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF INFRINGES ANY
INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.
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SOME STATES, PROVINCES OR LEGAL JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF
IMPLIED WARRANTIES, OR THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL
OR CONSEQUENTIAL DAMAGES, OR PERSONAL INJURY OR DEATH RESULTING FROM
NEGLIGENCE ON THE PART OF THE SELLER, SO THE ABOVE DISCLAIMERS AND EXCLUSIONS
MAY NOT APPLY TO YOU.

5. TERM:  This Agreement is effective upon your using the SOFTWARE and remains in effect until expiration of all
copyright interests in the SOFTWARE unless earlier terminated.  You may terminate this Agreement by destroying
the SOFTWARE.  This Agreement will also terminate without notice to you if you fail to comply with any of the
terms of this Agreement and you must then promptly return the SOFTWARE.  In addition, Canon may enforce its
other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE:
The SOFTWARE is a “commercial item,” as that term is defined at 48 C.F.R. 2.101 (Oct 1995), consisting of
“commercial computer software” and “commercial computer software documentation,” as such terms are used in 48
C.F.R. 12.212 (Sept 1995).  Consistent with 48 C.F.R. 12.212 and 48 C.F.R. 227.7202-1 through 227.72024 (June
1995), all U.S. Government End Users shall acquire the SOFTWARE with only those rights set forth herein.
Manufacturer is Canon Inc./30-2, Shimomaruko 3-chome, Ohta-ku, Tokyo 146-8501, Japan.

7. EXPORT RESTRICTIONS:  You agree to comply with all export laws and restrictions and regulations of the
country involved, and not to export or re-export, directly or indirectly, the SOFTWARE in violation of any such
laws and restrictions and regulations, or without all necessary approvals.

8. SEVERABILITY:
In the event that any provision of this Agreement is declared or found to be illegal by any court or tribunal of
competent jurisdiction, such provision shall be null and void with respect to the jurisdiction of that court or tribunal
and all the remaining provisions of this Agreement shall remain in full force and effect.

9. CONTROLLING LAW:  The terms of this Agreement as it relates to purchases of the Software in the United
States of America shall be governed and construed in all respects in accordance with the laws and regulations of the
State of New York, without reference to choice of law principles.  The terms of this Agreement as it relates to
purchases of the Software in Canada shall be governed by the laws of the province of Ontario.

10. OWNERSHIP:  All rights, including but not limited to copyrights and trade secret rights, to the SOFTWARE
belong to Canon, its affiliated corporations and third party licensors.  Your use of the SOFTWARE is subject to the
laws of the United States, and Canada, and other applicable copyright and trademark laws, and nothing in this
Agreement constitutes a waiver of the rights of Canon, its affiliated corporations and third party licensors under
such laws.  You only own the CD-ROM media in which the Software is stored.  Except as expressly provided
herein, no license or right, express or implied, is hereby conveyed or granted by Canon to you for any intellectual
property of Canon.  Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any
images, graphics or textual material that you save in connection with the Software.
You may not modify, remove or delete any or all copyright notices (i) which are contained in the Software,
including any copy thereof, and (ii) which are on the original CD-ROM and on the medium of a back-up copy made
pursuant to Section 2 above.

11. ACKNOWLEDGEMENT:  BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU HAVE
READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS TERMS AND
CONDITIONS.  YOU ALSO AGREE THAT THIS AGREEMENT IS THE COMPLETE AND EXCLUSIVE
STATEMENT OF AGREEMENT BETWEEN YOU AND CANON CONCERNING THE SUBJECT
MATTER HEREOF AND SUPERSEDES ALL PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR
WRITTEN, AND ANY OTHER COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE
SUBJECT MATTER HEREOF.  NO AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE
UNLESS SIGNED BY A DULY AUTHORIZED OFFICER OF CANON.
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Canon DVC Storage Driver License Agreement

READ CAREFULLY BEFORE USING

EXHIBIT A TO
IFG CODE TECHNOLOGY LICENSE AGREEMENT

SHRINK WRAP LICENSE

BY PUTTING THE DISKETTE INTO YOUR DISK DRIVE OR PUTTING THE CD-ROM INTO YOUR
CD-ROM DRIVE YOU, THE END USER (“LICENSEE”) INDICATE YOUR ACCEPTANCE OF THE
TERMS OF THIS SHRINK WRAP LICENSE AGREEMENT (“AGREEMENT”) BETWEEN YOU AND
CANON INC. (“COMPANY”).  COMPANY WILL ONLY GRANT YOU A LICENSE TO THE
SOFTWARE PROVIDED UNDER THIS AGREEMENT ON THE CONDITION THAT YOU AGREE TO
THE TERMS OF THIS AGREEMENT.  IF YOU DO NOT AGREE TO THE TERMS OF THIS
AGREEMENT, PROMPTLY RETURN THE DISKETTE OR CD-ROM TO COMPANY OR ITS
AUTHORIZED DEALER.

1. LICENSE GRANT.  Subject to Company’s receipt of payment for this license and Licensee’s compliance with the
terms and conditions of this Agreement, Company hereby grants Licensee a non-exclusive, nontransferable
copyright license to allow Licensee to install the object code copies of the programs that are loaded onto media
provided by Company (the “Software”), only on Licensee’s computers that use Company’s product, and for no
other purpose whatsoever.  The rights and licenses regarding the Software granted under this Agreement are not
transferable or sublicenseable by Licensee, including to other entities that control, are controlled by or are under
common control with Licensee.  Under no circumstance shall Licensee, whether directly or through any third
parties, either disassemble, decompile, or reverse engineer the Software.

2. COPIES.  Licensee may not copy the Software or any part of the Software, except to make a single copy of the
Software for backup or archival purposes only, and such single copy must bear all proprietary legends that are on
the original Software program.  Licensee agrees to be responsible for any copying or copyright infringement of the
Software in violation of this Agreement.  The Software is licensed only as a single integrated product.  The
Software may not be separated, used, or copied on more than one computer.  Licensee may not transfer the Software
to another user except as part of the permanent transfer of the Software to such other user, and then only if such
other user agrees to all terms of this Agreement in advance of such transfer, and then only if the initial Licensee
retains no copies of the Software following such transfer.

3. PROPRIETARY SOFTWARE.  The Software is proprietary to Phoenix Technologies Ltd., located at 411 East
Plumeria Drive, San Jose, California 95134 (“Phoenix”) and its suppliers.  All applicable rights to patents,
copyrights, trademarks and trade secrets in the Software or any modifications made by Phoenix to the Software are
and shall remain in Phoenix and its suppliers.  Phoenix and its suppliers reserve all rights not expressly granted in
this Agreement.  By accepting this license, Licensee acknowledges that the Software and accompanying materials,
and any proprietary information contained in the media, are proprietary in nature and were developed or acquired at
great expense.  Licensee agrees not to disclose to others or utilize such trade secrets or proprietary information
except as provided herein.

4. EXPORT AND TAXES.  Licensee certifies that neither the Software nor any portion of the Software will be
exported to any country in violation of the United States Export Administration Act or related laws and regulations.
Licensee shall be liable for and shall pay all charges and taxes (local, state, federal and foreign), including all sales
and use taxes, which may now or in the future be imposed or levied upon the license or possession of the Software,
excluding taxes based on Company’s income.

5. WARRANTIES AND LIMITATION OF LIABILITY.  Licensee understands and agrees that the Software is
provided “AS IS” WITH NO WARRANTIES WHATSOEVER FROM PHOENIX AND ITS SUPPLIERS,
WHETHER EXPRESS, IMPLIED OR STATUTORY, INCLUDING, BUT NOT LIMITED TO ANY WARRANTY
OF MERCHANTABILITY, NONINFRINGEMENT, FITNESS FOR ANY PARTICULAR PURPOSE, OR ANY
WARRANTY OTHERWISE ARISING OUT OF ANY PROPOSAL, SPECIFICATION, OR SAMPLE. IN NO
EVENT WILL PHOENIX OR ITS SUPPLIERS BE LIABLE TO LICENSEE FOR ANY LOSS OF PROFITS,
LOSS OF USE, INCIDENTAL, CONSEQUENTIAL, INDIRECT, OR SPECIAL DAMAGES ARISING OUT OF
THIS AGREEMENT, WHETHER OR NOT PHOENIX OR ITS SUPPLIERS HAVE ADVANCE NOTICE OF
THE POSSIBILITY OF SUCH DAMAGES.

6. TERMINATION.  The Software license granted under this Agreement is effective until terminated, and will
terminate immediately without notice to Licensee in the event Licensee fails to comply with any provision of this
Agreement.  Upon any such termination, Licensee must destroy the Software, any copies, and any related
documentation.  Licensee’s obligations under this Agreement shall survive termination of the license granted under
this Agreement for the earlier of the longest term allowed by applicable law or until Phoenix makes the Software
available to the public without restrictions on disclosure.

7. GENERAL.  Licensee agrees that it has read this Agreement, understands it, agrees to be bound by its terms, and
that this Agreement is the complete and exclusive agreement between Company and Licensee, and supersedes and
merges all prior oral or written understandings between the parties relating to this Agreement



5

W
in

d
o

w
s

E

Contents
READ CAREFULLY BEFORE USING ............................................................................... 2

Canon Software License Agreement ................................................................................ 2
Canon DVC Storage Driver License Agreement ............................................................. 4

Read Me First ........................................................................................................................ 6
Confirm the Supplied Accessories ................................................................................... 7

  Windows
System Requirements ............................................................................................................ 8
What Can Be Accomplished with the Software .................................................................... 9
Installing from the Canon DIGITAL VIDEO SOLUTION DISK ...................................... 10
Installing the DVC Storage Driver/Disconnecting the camcorder from the computer

Windows 98 ...................................... 12 Windows Me ................................... 17
Windows 2000 .................................. 21 Windows XP ................................... 27

Connecting the Camcorder to a Computer .......................................................................... 32
Downloading Images to a Computer (ZoomBrowser EX) .................................................. 33

The ZoomBrowser EX Camera Window ....................................................................... 35
Understanding the Browser Window ............................................................................. 36
Downloading and Saving Images from the Camcorder ................................................. 37
ZoomBrowser EX Features ............................................................................................ 39

Printing Images (PhotoRecord) ........................................................................................... 42
PhotoRecord Window ..................................................................................................... 44

Merging Panoramic Images with PhotoStitch ..................................................................... 45
To Merge Images Registered in ZoomBrowser EX ....................................................... 45

Adding Still Images from Your Computer to the Memory Card ......................................... 48
Uninstalling the Software .................................................................................................... 50

When Uninstalling the DVC Storage Driver
Windows 98 ...................................... 15 Windows Me ................................... 19
Windows 2000 .................................. 24 Windows XP ................................... 30

Troubleshooting ................................................................................................................... 51

  Macintosh
System Requirements .......................................................................................................... 53
What Can Be Accomplished with the Software .................................................................. 54
Installing from the Canon DIGITAL VIDEO SOLUTION DISK ...................................... 55
Installing the DVC Storage Driver ...................................................................................... 56
Connecting the Camcorder to a Computer .......................................................................... 57

Connecting to a USB Port .............................................................................................. 57
Disconnecting the camcorder from the computer .......................................................... 58

Downloading Images to a Computer (ImageBrowser) ........................................................ 59
The ImageBrowser Camera Window ............................................................................. 60
Understanding the Browser Window ............................................................................. 61
Downloading and Saving Images from the Camcorder ................................................. 62

Printing Images (ImageBrowser) ........................................................................................ 65
Print Window .................................................................................................................. 66

Merging Panoramic Images with PhotoStitch ..................................................................... 67
To Merge Images Registered in ImageBrowser ............................................................. 67

Adding Still Images from Your Computer to the Memory Card ......................................... 70
Uninstalling the Software .................................................................................................... 72
Troubleshooting ................................................................................................................... 73



6

Read Me First

You can connect a camcorder with a USB terminal to the PC using a USB cable to
download still images recorded on the memory card of the camcorder. You can also
use the software provided to sort, store, and print still images.

Disclaimer
• While every effort has been made to ensure that the information contained in this

guide is accurate and complete, no liability can be accepted for any errors or
omissions. Canon reserves the right to change the specifications of the hardware
and software described herein at any time without prior notice.

• No part of this guide may be reproduced, transmitted, transcribed, stored in a
retrieval system, or translated into any language in any form, by any means,
without the prior written permission of Canon.

• Canon makes no warranties for damages resulting from corrupted or lost data
due to mistaken operation or malfunction of the camcorder, the software,
memory cards (MultiMediaCards or SD Memory Cards), personal computers, or
peripheral devices, or due to use of a memory card not formatted by a Canon
camcorder.

Trademark Acknowledgments
• Canon is a trademark of Canon Inc.
• Adobe is a trademark of Adobe Systems Incorporated.
• iBook and iMac are trademarks of Apple Computer, Inc.
• Macintosh, PowerBook, Power Macintosh and QuickTime are trademarks of

Apple Computer Inc., registered in the United States and other countries.
• Microsoft, Windows and Windows NT are either registered trademarks or

trademarks of Microsoft Corporation in the United States and/or other countries.
• Other names and products not mentioned above may be registered trademarks or

trademarks of their respective companies.

Copyright © Canon Inc. 2002 All rights reserved.

Safty Precautions
• Do not play the supplied CD-ROM(s) in any CD player that does not support

data CD-ROMs. Playing the CD-ROM(s) in an audio CD player (music player)
could damage the speakers. It is also possible to suffer from hearing loss from
listening with headphones to the loud sounds of a CD-ROM played on a music
CD player.
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Confirm the Supplied Accessories
Use the following accessories to download recorded images from a memory card to
your computer.
• IFC-300PCU USB Cable

• Canon DIGITAL VIDEO SOLUTION DISK
Software CD-ROM

- Windows users: Go to p. 8.
- Macintosh users: Go to p. 53.
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Windows  System Requirements

Please install the software on a computer meeting the following minimum require-
ments.

Computer Model:
IBM PC/AT compatible

OS:
Windows 98 (First or Second Edition), Windows Millennium Edition (Windows
Me), Windows 2000, Windows XP
Proper operation is not guaranteed on an OS that has been upgraded from a
previous version.

CPU:
Pentium 150 MHz or better (Windows XP: Pentium 300 MHz or better)

RAM:
Windows 98: 32 MB or more, Windows Me/Windows 2000: 64 MB or more,
Windows XP: 128 MB or more

Interface:
USB: only preinstalled Windows 98/Windows Me/Windows 2000/Windows XP
systems with built-in USB ports

Free Hard Disk Space:
• Canon Utilities

- ZoomBrowser EX: 120 MB or more  (Including the PhotoRecord printing
program)

- PhotoStitch: 40 MB or more
Display:

800 × 600 pixels/256 colors (8 bit) or better, 1,024 × 768 pixels/High Color (16
bit) or better is recommended

 Notes:
• The USB interface is only supported for those computers that come preinstalled

with Windows 98/Windows Me/Windows 2000/Windows XP and have built-in
USB ports.

• Proper operation is not guaranteed on a dual CPU PC or on a user-built PC.
• Proper operation is not guaranteed on any particular system, even if it meets the

requirements outlined above.
• A CD-ROM drive is required to install the software.
• Connect the camcorder directly to a USB port on the computer; not through a

hub. The connection may not operate correctly through a hub.
• The connection may not operate correctly if you are using other USB devices,

excluding USB mice or keyboards, at the same time. If this occurs, disconnect
the other devices from the computer and try reconnecting the camcorder.

• Do not connect two or more camcorders to the same computer via the USB
interface. The connections may not operate correctly.
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What Can Be Accomplished with the Software

This topic introduces the main features of the software programs contained on the
CD-ROMs.

■ DVC Storage Driver (  12)
• Driver software required for connecting the camcorder to your PC using a

USB cable. Makes it possible to use the camcorder as a memory card reader/
writer.

■ ZoomBrowser EX (  33)
• Downloading still images recorded onto a memory card to your computer.
• Categorizing and Organizing Large Volumes of Images*.
• Searching and Organizing Images Chronologically*.
• Creating Mail Attachments from Images*.

■ PhotoRecord (  42)
• Laying Out and Printing Images.
• Programs for Printing Indexes.

■ PhotoStitch (  45)
• Merging Panoramic Images.

This instruction manual explains how to install the software, what you can do with
the main features and how to operate them. For more detailed operational
instructions, refer to the ZoomBrowser EX Software User Guide (PDF format) or
the Help menu of each software program. (*: For instructions on these features,
refer to the ZoomBrowser EX Software User Guide.)

About the ZoomBrowser EX Software User Guide
In order to view the ZoomBrowser EX Software User Guide, it is required that
Adobe Acrobat Reader is installed on your computer. If it is not, install it according
to “How to install Adobe Acrobat Reader” below.

How to view the ZoomBrowser EX Software User Guide
qPlace the Canon Digital Video Solution Disk in the computer’s CD-ROM drive.

The installer panel will display.
w In the installer panel, click [ZoomBrowser EX Software Guide].

The guide will display.
• If the installer panel does not display automatically, open the [Readme] and

[English] folders on the CD-ROM and double-click the [ZOOMBROWSER EX
GUIDE.PDF] file.

How to install Adobe Acrobat Reader
qPlace the Canon Digital Video Solution Disk in the computer’s CD-ROM drive.
wOpen the [Readme], [Acrobat-English] folders.
eDouble-click the [ar405eng.exe] file to start the installer.
Follow the onscreen instructions to install Adobe Acrobat Reader.
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Installing from the Canon DIGITAL VIDEO SOLUTION DISK

1. Close any programs that are running.
• Users of Windows 2000, Windows XP Professional must first log in as an

Administrator to install programs.

2. Set the Canon DIGITAL VIDEO SOLUTION DISK in the
computer’s CD-ROM drive.
• The installer panel will display automatically.
• If the installer panel does not appear automatically, use the following

procedures to display it.
q Double-click the [My Computer] icon on the desktop to open it and

double-click the CD-ROM icon.
w Double-click the [Setup] icon.

3. Click [Digital Video Software Installation].

4. Confirm the target folder for the installation and click the [Next]
button.
• Normally, select (C: ).

5. Click the [Next] button.

Installer Panel
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6. Confirm the program selection and click the [Next] button.

• The installation will start.
• Follow the onscreen messages to proceed with the installation.

7. After the installation is complete and the installer panel displays
again, click the [Exit] button.
• The installer panel disappears.
• Depending on the computer you are using, the installer panel might not

display again after the installation is complete. Restart your computer if you
are prompted to.

Next, install the DVC Storage Driver. Do not remove the CD-ROM
from the computer’s drive.
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Installing the DVC Storage Driver

The procedure for installation of the DVC Storage Driver differs depending on the
computer you are using. Confirm the OS of your computer and go to the
appropriate page as stated below.
Windows 98 (  12), Windows Me (  17), Windows 2000 (  21),
Windows XP (  27).

Cautions:
• Be sure to install the DIGITAL VIDEO SOLUTION DISK before you connect

the camcorder to the computer.
• Once you connect the camcorder to your computer after installing the Digital

Video Solution Disk, make absolutely sure not to turn off the camcorder before
installation of the DVC Storage Driver is complete.

Windows 98

Installing the DVC Storage Driver

1. Connect the camcorder to an AC outlet.

2. Attach the supplied USB cable to the computer’s USB port and the
camcorder’s USB terminal. (  32)

3. Set the camcorder to CARD PLAY(VCR) mode.
• The Add New Hardware Wizard will open.

4. Click [Next].

5. Select [Search for the best driver for your device. [Recommended].]
and then click [Next].
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6. Select [Specify a location:] and then click [Browse...].

• If a check mark ( ) is displayed beside [CD-ROM drive], click it to remove
it.

7. On the [Browse for Folder] window, select [Win98] in the folder
named [STORAGE DRIVER] on the CD-ROM, and then click
[OK].

8. For [Specify a location:] display [G:\STORAGE DRIVER\WIN98],
and then click [Next].
• The drive letter (e.g. “G:”) varies depending on the computer you are using.

Windows 98

Be sure to select this.

Be sure to select Win98.
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9. Click [Next].
• Driver installation starts.

10.Click [Finish].
• Installation ends and the driver is registered by Explorer as [Removable

Disk].

11.Check if the DVC Storage Driver has been installed correctly.
• Check if “Removable Disk” is shown in Explorer. If “Removable Disk” is

not shown, restart your computer. In case “Removable Disk” does not
appear even if you have restarted your computer, installation has not been
done correctly ( 51).

Installing the DVC Storage Driver

Windows 98
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Disconnecting the camcorder from the computer

1. Turn off the camcorder and detach the USB cable.

● To detach the cable, always hold the connector by its sides to pull it out.
● Turn off the camcorder before inserting/removing the memory card.

● When Uninstalling the DVC Storage Driver
If DVC Storage Driver installation has not been done correctly, or when otherwise
necessary, uninstall the driver.

1. Attach the supplied USB cable to the computer’s USB port and the
camcorder’s USB terminal. (  32)

2. On the [Start] menu, select [Settings] > [Control Panel].

3. Double-click the [System] icon.

4. Click the [Device Manager] tab.

5. Check if [Canon DVC] or [USB device] is displayed under [Other
devices], [Imaging Device] or [Universal Serial Bus controllers].
• If [Canon DVC] or [USB device] is found:

q Click [Canon DVC] or [USB device].
w Click [Remove].
e If a confirmation message appears, click [OK] and close [System

Properties].
• If there are multiple [Canon DVC] or [USB device] entries under

[Other devices], [Imaging Device] or [Universal Serial Bus
controllers], delete all of them.

Windows 98

Check here
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6. From [My Computer] on the desktop, double-click q [C:], w the
[WINDOWS] folder, e the [INF] folder, and then r the [OTHER]
folder.
• If you cannot find the [INF] folder inside the [WINDOWS] folder in step

6-w, perform the following steps.
1 On the [View] menu, select [Folder Options].
2 Click the [View] tab.
3 Under [Hidden Files], select [Show all files].
4 Click [OK].

• The [Folder Options] dialog box closes.
• You will now be able to see the folders and files you could not see

previously.

7. Delete [Canon Inc. CANDV_98.INF].

Caution:
• The Inf folder contains numerous files that are critical to the computer’s opera-

tion. Be extremely careful not to delete the wrong files. If you delete the wrong
file, you may be unable to restart Windows.

Installing the DVC Storage Driver

Windows 98
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Windows Me

Be sure to select this file.

Windows Me

Installing the DVC Storage Driver

1. Connect the camcorder to an AC outlet.

2. Attach the supplied USB cable to the computer’s USB port and the
camcorder’s USB terminal. (  32)

3. Set the camcorder to CARD PLAY(VCR) mode.
• The Add New Hardware Wizard will open.

4. Select [Automatic search for a better driver [Recommended]] and
then click [Next].

5. On the [Select Other Driver] window, select [F:\STORAGED\
WINME\CANDV_ME. INF] and then click [OK].
• The drive letter (e.g. “F:”) varies depending on the computer you are using.
• Driver installation starts.
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6. Click [Finish].
• Installation ends and the driver is registered by Explorer as [Removable

Disk].

7. Check if the DVC Storage Driver has been installed correctly.
• Check if “Removable Disk” is shown in Explorer. If “Removable Disk” is

not shown, restart your computer. In case “Removable Disk” does not
appear even if you have restarted your computer, installation has not been
done correctly ( 51).

Windows Me

Installing the DVC Storage Driver

Disconnecting the camcorder from the computer

1. Click the  icon in the task bar.
• If the icon is not displayed in the task bar, turn off your computer and then

detach the USB cable.

2. Click [Stop USB Disk - Drive[G:]].
• A message will appear on the display indicating it is safe to remove the

device.
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Windows Me

3. Click [OK].

4. Turn off the camcorder and detach the USB cable.

● To detach the cable, always hold the connector by its sides to pull it out.
● Turn off the camcorder before inserting/removing the memory card.

● When uninstalling the DVC Storage Driver
If DVC Storage Driver installation has not been done correctly, or when otherwise
necessary, uninstall the driver.

1. Attach the supplied USB cable to the computer’s USB port and the
camcorder’s USB terminal. (  32)

2. On the [Start] menu, select [Settings (S)] > [Control Panel (C)].

3. Double-click the [System] icon.

4. Click the [Device Manager] tab.

5. Check if [Canon DVC] or [USB device] is displayed under [Other
devices], [Imaging Device] or [Universal Serial Bus controllers].
• If [Canon DVC] or [USB device] is found:

q Click [Canon DVC] or [USB device].
w Click [Remove].
e If a confirmation message appears, click [OK] and close [System

Properties].
• If there are multiple [Canon DVC] or [USB device] entries under

[Other devices], [Imaging Device] or [Universal Serial Bus
controllers], delete all of them.

Check here
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6. From [My Computer] on the desktop, double-click q [C:], the w
[WINDOWS] folder, e the [INF] folder, and then the r [OTHER]
folder.
• If you cannot find the [INF] folder inside the [WINDOWS] folder in step 6-

w, perform the following steps.
1 On the [Tools] menu, select [Folder Options].
2 Click the [View] tab.
3 Under [Hidden Files and Folders], select [Show hidden files and folders].
4 Click [OK].

• The [Folder Options] dialog box closes.
• You will now be able to see the folders and files you could not see

previously.

7. Delete [Canon Inc. CANDV_ME.INF].

Caution:
• The Inf folder contains numerous files that are critical to the computer’s opera-

tion. Be extremely careful not to delete the wrong files. If you delete the wrong
file, you may be unable to restart Windows.

Installing the DVC Storage Driver

Windows Me
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5. Select [Search for a suitable driver for my device [recommended]]
and then click [Next].

Windows 2000

Windows 2000

Installing the DVC Storage Driver
User of Windows 2000 must first log in as an Administrator to install programs.

1. Connect the camcorder to an AC outlet.

2. Attach the supplied USB cable to the computer’s USB port and the
camcorder’s USB terminal. (  32)

3. Set the camcorder to CARD PLAY(VCR) mode.
• The Found New Hardware Wizard will open.

4. On the [Found New Hardware Wizard] dialog box, click [Next].
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Installing the DVC Storage Driver

7. Click [Browse...].

8. For [Look in:], select the CD-ROM, [STORAGE DRIVER],
[WIN2000] and [CANDV_2K], and then click [Open].

9. Click [OK].

Windows 2000

6. Select [Specify a location] and then click [Next].
• If a check mark ( ) is displayed beside [CD-ROM drive], click it to remove it.

Be sure to select this.



23

W
in

d
o

w
s

E

11.Click [Finish].
• Installation ends and the driver is registered by Explorer as [Removable

Disk].

12.Check if the DVC Storage Driver has been installed correctly.
• Check if “Removable Disk” is shown in Explorer. If “Removable Disk” is

not shown, restart your computer. In case “Removable Disk” does not
appear even if you have restarted your computer, installation has not been
done correctly ( 51).

Windows 2000

10.Click [Next].
• Driver installation starts.
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3. Click [OK].

Installing the DVC Storage Driver

4. Turn off the camcorder and detach the USB cable.

● To detach the cable, always hold the connector by its sides to pull it out.
● Turn off the camcorder before inserting/removing the memory card.

● Uninstalling the DVC Storage Driver
If DVC Storage Driver installation has not been done correctly, or when otherwise
necessary, uninstall the driver.

1. Attach the supplied USB cable to the computer’s USB port and the
camcorder’s USB terminal. (  32)

2. On the [Start] menu, select [Settings] > [Control Panel].

3. Double-click the [System] icon.

4. Click the [Hardware] tab in the [System Properties] dialog.

5. Click [Device Manager].

Windows 2000

Disconnecting the camcorder from the computer

1. Click the  icon in the task bar.
• If the icon is not displayed in the task bar, turn off your computer and then

detach the USB cable.

2. Click [Stop Canon DVC - Drive(H:)].
• The message [The 'Canon DVC' device can now be safely removed form the

system] will appear on the display.
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6. Check if [Canon DVC] or [USB device] is displayed under [Other

devices], [Imaging Device] or [Universal Serial Bus controllers].
• If [Canon DVC] or [USB device] is found:

q Right-click [Canon DVC] or [USB device] and select [uninstall].
w If a confirmation message appears, click [OK] and close [Device

Manager] and [System Properties].
• If there are multiple [Canon DVC] or [USB device] entries under

[Other devices], [Imaging Device] or [Universal Serial Bus
controllers], delete all of them.

7. From [My Computer] on the desktop, double-click q [C:], w the
[Winnt] folder, and then e the [Inf] folder.
• If you cannot find the [Inf] folder inside the [Winnt] folder in step 7-w,

perform the following steps.
1 Double-click the [Winnt] folder.
2 On the [Tools] menu, select [Folder Options].
3 Click the [View] tab.
4 Under [Advanced Settings] [Files and Folders], select [Show hidden files

and folders].
5 Click [OK].

• The [Folder Options] dialog box closes.
• You will now be able to see the folders and files you could not see

previously.

Windows 2000

Check here
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8. Double-click [Oem*].
• The asterisk (*) in  the above stands for a value.
• The [Oem*] file is grouped with a file named [Oem*.pnf], which shares the

same number in the position of the asterisk.
• The [Inf] file may contain multiple [Oem*] file groups.
• Double-clicking [Oem*] opens Notepad and displays the file contents.

Repeat the above steps until you find the [Oem*] file with [;***Canon
Digital Video Camera USB Setup File****] in its first line.
After checking the content of the file, make a note of the file name.

9. Delete the [Oem*] file.
• Making sure that you do not make a mistake and delete the wrong file,

delete the [Oem*] file and the [Oem*.pnf] file that corresponds to it.

Caution:
• The Inf folder contains numerous files that are critical to the computer’s opera-

tion. Be extremely careful not to delete the wrong files. If you delete the wrong
file, you may be unable to restart Windows.

Windows 2000
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Windows XP

Installing the DVC Storage Driver
User of Windows XP Professional must first log in as an Administrator to install
programs.

1. Connect the camcorder to an AC outlet.

2. Attach the supplied USB cable to the computer’s USB port and the
camcorder’s USB terminal. (  32)

3. Set the camcorder to CARD PLAY(VCR) mode.
• “Found New Hardware” will appear on the display.

4. On the [Found New Hardware Wizard] screen, select [Install from
a list or specific location [Advanced].] and then click [Next].

5. Select [Search for the best driver in these locations.] and then
[Include this location in the search: ]. Then click [Browse].
• If a check mark ( ) is displayed beside [Search removable media (floppy,

CD-ROM...)], click it to remove it.

Be sure to select this.

Windows XP
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Installing the DVC Storage Driver

7. Click [Next].
• Driver installation starts.

6. For [Browse For Folder], select [WINXP] in the [STORAGE
DRIVER] folder on the CD-ROM, and then click [OK].

Be sure to select this.

8. Click [Finish].
• Installation ends and the driver is registered by Explorer as [Removable

Disk].

Windows XP
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Disconnecting the camcorder from the computer

1. Click the  icon in the task bar.
• If the icon is not displayed in the task bar, turn off your computer and then

detach the USB cable.

2. Click [Safely remove Canon DVC - Drive (E:)].
• The message [Safe To Remove Hardware] will appear on the display.

3. Turn off the camcorder and detach the USB cable.

● To detach the cable, always hold the connector by its sides to pull it out.
● Turn off the camcorder before removing the memory card.

Windows XP

9. Check if the DVC Storage Driver has been installed correctly.
• Check if “Removable Disk” is shown in Explorer. If “Removable Disk” is

not shown, restart your computer. In case “Removable Disk” does not
appear even if you have restarted your computer, installation has not been
done correctly. (  51)

Caution:
• The image files on your memory card and the image files you have stored

(downloaded) to the hard disk drive of your computer are your valuable, original
image files. If you wish to use image files on your computer, be sure to make
copies of them first, and use the copied file, retaining the original.
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Installing the DVC Storage Driver

Windows XP

● When Uninstalling the DVC Storage Driver
If DVC Storage Driver installation has not been done correctly, or when otherwise
necessary, uninstall the driver.

1. Attach the supplied USB cable to the computer’s USB port and the
camcorder’s USB terminal. (  32)

2. On the [Start] menu, select [Control Panel (C)].

3. Select [Performance and Maintenance] > [System].

4. Click the [Hardware] tab in the [System Properties] dialog.

5. Click [Device Manager].

6. Check if [Canon DVC] or [USB device] is displayed under [Other
devices], [Imaging devices] or [Universal Serial Bus controllers].
• If [Canon DVC] or [USB device] is found:

qRight-click [Canon DVC] or [USB device] and select [Unistall].
w If a confirmation message appears, click [OK] and close [Device

Manager] and [System Properties].
• If there are multiple [Canon DVC] or [USB device] entries under

[Other devices], [Imaging devices] or [Universal Serial Bus
controllers], delete all of them.

Click here
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8. Double-click [Oem*].
• The asterisk (*) in  the above stands for a value.
• The [Oem*] file is grouped with a file named [Oem*.pnf], which shares the

same number in the position of the asterisk.
• The [Inf] file may contain multiple [Oem*] file groups.
• Double-clicking [Oem*] opens Notepad and displays the file contents.

Repeat the above steps until you find the [Oem*] file with [;***Canon
Digital Video Camera USB Setup File****] in its first line.
After checking the content of the file, make a note of the file name and then
close Notepad.

9. Delete the [Oem*] file.
• Making sure that you do not make a mistake and delete the wrong file,

delete the [Oem*] file and the [Oem*.pnf] file that corresponds to it.

Caution:
• The Inf folder contains numerous files that are critical to the computer’s

operation. Be extremely careful not to delete the wrong files. If you delete the
wrong file, you may be unable to restart Windows.

7. From [Start] menu on the desktop, select [My Computer]. Double-
click q [C:], w the [WINDOWS] folder, and then e the [Inf] folder.
• If you cannot find the [Inf] folder inside the [WINDOWS] folder in step 7-

w, perform the following steps.
1 Double-click the [WINDOWS] folder.
2 On the [Tools] menu, select [Folder Options].
3 Click the [View] tab.
4 Under [Advanced Settings] [Hidden Files and Folders], select [Show

hidden files and folders].
5 Click [OK].

• The [Folder Options] dialog box closes.
• You will now be able to see the folders and files you could not see

previously.

Windows XP
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USB Cable

Camcorder End Computer End

USB Terminal
on the Camcorder

USB Port on 
the Computer

2. The driver software will install the first time (only) you connect via
the USB interface. (  12)

Connection Precautions
• Make sure the camcorder is being powered using the compact power adapter

before connecting it to a computer.
• Be sure to install the DIGITAL VIDEO SOLUTION DISK before you connect

the camcorder to the computer.
• Connect the camcorder directly to a USB port on the computer; not through a

hub. The connection may not operate correctly through a hub.
• The connection may not operate correctly if you are using other USB devices,

excluding USB mice or keyboards, at the same time. If this occurs, disconnect
the other devices from the computer and try reconnecting the camcorder.

• Do not connect two or more camcorders to the same computer via the USB
interface. The connections may not operate correctly.

• Never allow the computer to go into standby (sleep) mode while a camcorder
is connected via the USB interface. If it does happen, never disconnect the
USB cable. Try to awaken the computer with the camcorder in the con-
nected state. Some computers will not awaken properly if you disconnect the
camcorder while they are in standby mode. Please refer to your computer
manual for instructions regarding its standby mode.

1. Attach the supplied USB cable to the computer’s USB port and the
camcorder’s USB Terminal.
• You do not need to turn off the computer for this procedure.
• Refer to your computer manual for the location of the computer’s USB

ports.
• See your camcorder instruction manual for connecting instructions.

Connecting the Camcorder to a Computer
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Canon ZoomBrowser EX Icon

Downloading Images to a Computer (ZoomBrowser EX)

Cautions:
• Make sure you observe the following precautions whenever an image is being

read from or written to the memory card (which is indicated when the
camcorder’s card access indicator is flashing).  Failure to do so can cause
memory card data to become corrupted.
– Never remove the memory card or detach the USB cable.
– Never turn off the camcorder or computer.

• Do not format memory cards on a computer.
• The image files on your memory card and the image files you have stored

(downloaded) to the hard disk drive of your computer are your valuable, original
image files. If you wish to use image files on your computer, be sure to make
copies of them first, and use the copied file, retaining the original.

1. Insert the memory card to the camcorder.

2. Connect the camcorder to an AC outlet.

3. Attach the supplied USB cable to the computer’s USB port and the
camcorder’s USB terminal. (  32)

4. Set the camcorder to CARD PLAY(VCR) mode.

5. Double-click the [Canon ZoomBrowser EX] icon on the desktop.
• ZoomBrowser EX will start.
• If you are using Windows Me, a confirmation message will appear the first

time ZoomBrowser EX starts, asking whether you wish to register the [My
Pictures] folder in ZoomBrowser EX. Click [Yes] if you plan to use the My
Pictures folder.
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Downloading Images to a Computer (ZoomBrowser EX)

 Note:
• When ZoomBrowser EX is installed under Windows XP, you can configure it to

start up automatically any time the camcorder is connected to the computer.
qSelect [Download Images using ZoomBrowser EX].
wClick [OK].

• The camera window will appear on the display.

6. Click the [IMPORT IMAGES] button and select [From Dcim...].
• Thumbnail versions of the camcorder images will display in the Camera

window.
• No image will be imported if you click [From Canon Camera].  Make sure

you select [From Dcim].
• The drive letter (e.g. “H:”) varies depending on the computer you are using.
• If you cannot find [From Dcim], quit ZoomBrowser EX and start it again.
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 Notes:
About the other buttons
• [SELECT]: You can select all of the images or deselect images, etc.

[ROTATE]: You can rotate (90 degrees counterclockwise/90 degrees clockwise/
180 degrees) the images.
[IMAGE INFO]: You can confirm the number of pixels or the file size of the
selected image.

• You cannot use the [SETUP OPTIONS] and [CONNECT CAMERA] functions.
• You cannot use the [SLIDE] function (to select images for inclusion in a slide

show) of the [SLIDE/DPOF] button.

The ZoomBrowser EX Camera Window
When a connection is opened to a memory card in a camcorder, the card’s images
display as thumbnails in the Camera window.
The buttons are activated when any images are selected.

Thumbnail
The image is displayed 
reduced in size.

Delete Button
Delete selected 
images.

Download Button
Load the selected 
images onto the 
computer (      37).

Upload Button
Copy images from the 
computer onto the 
memory card (      48).

Print Button
Select the printing 
method: Layout or Index.
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Downloading Images to a Computer (ZoomBrowser EX)

Understanding the Browser Window
This section describes the various parts of the Browser Window and explains how
to change the way the control panel is displayed.

Changing the way the control panel is displayed
• Clicking the t button displays the control panel as a floating toolbar. To return to the original

state, click the r button.
• Furthermore, while the control panel is displayed as a floating toolbar, you can place it

under the menu or at the very bottom of the Browser Window.

Image Folder
An image folder 
is a folder (on 
your PC), which 
has been 
registered in 
ZoomBrowser 
EX for storing 
images.

Folder
A folder is a 
subfolder of an 
image folder 
that can be 
used to further 
classify images.

Tree View
This is the area in 
the Browser 
Window where 
folders registered 
as image folders 
are displayed.

You can drag this line to 
change the position of 
the boundary between 
the Tree View and the 
Browser Display Area.

Browser Display 
Area
This is the area 
where thumbnails 
of the selected 
image folder and 
folders are 
displayed.

Message Area
This is the area 
where information 
about the selected 
image folder and 
folders is 
displayed.

Control Panel
This area contains buttons that 
allow you to perform a variety of 
functions.

The title bar displays the path (folder hierarchy) to the selected 
image folder or folder.
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Tree View Area

Thumbnail

3. Select the images you wish to download from the Camera window
and click the [Download] button.
• Click on thumbnails to select them. The color of the frame(s) around the

thumbnail(s) you selected will change to be blue.
• To select multiple images, hold down the Shift key or Ctrl key while clicking.
• Downloaded images are saved to the computer disk and appear in the

Browser Display Area.

2. Click the new folder in the Tree View area.

Downloading and Saving Images from the Camcorder

1. Create a new folder for saving images from the memory card in the
camcorder.
• In the Tree View area, right-click the [Image Library One] folder, select

[New Folder] from the pop-up menu and input a folder name. In this
example, we will input “Travel.”
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Downloading Images to a Computer (ZoomBrowser EX)

Browser Display Area

Tree View Area

 Notes:
• The folder you created above normally appears within the [C:\Program

Files\Canon\ZoomBrowser EX\Image Library One] folder. The downloaded
image files are saved to the folder you created.

• You can also download images by dragging them from the Camera window and
dropping them on the Browser Display Area or Tree View area.

• The [My Camera] item (which allows you to configure camcorder startup sound
and image on your computer) on the ZoomBrowser EX [Edit] menu is disabled
and cannot be used.

• To disconnect the camcorder, click the close box  at the right of the Camera
window to close it.
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Scroll Mode Button
Switches to and from 
the scroll mode.

Refresh Button
Updates the folder contents.

Register Image Folder Button
Registers the selected folder as an Image Folder.

Zoom Mode Button
Switches to and from the zoom mode.

The images inside the 
sub-folders also display.

The images inside the 
sub-folders do not display.

Scroll Bar

■ Zoom Mode
When you create a folder within a folder, use this mode to display all the images
inside the sub-folder too.

■ Scroll Mode
Use this mode to just display the images within one folder. When there are more
images than can fit in the Browser Display Area, scroll bars appear on the right of
the Browser Display Area. The sub-folders only appear as folder icons in this mode.

Switching the Display Mode

You can change between the Zoom and Scroll modes to suit your purposes when
images are displayed in the Browser Display Area.

ZoomBrowser EX Features
This topic introduces additional, convenient ZoomBrowser EX features (Zoom
Mode/Scroll Mode/Registering a Folder as an Image Folder/Refreshing a Folder).

Using the ZoomBrowser EX Buttons

The bottom of the ZoomBrowser EX window contains the buttons that control
various functions. This topic describes four of those buttons that are particularly
convenient.
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Downloading Images to a Computer (ZoomBrowser EX)

2. Select the folder you wish to register and click the [OK] button.
• The folder will be registered as an Image Folder.

■ Registering a Folder as a Image Folder
Folders shown in the Tree View area with a  symbol are called Image Folder.
ZoomBrowser EX only manages the images contained in these folders and the
subfolders nestled within them.

1. Click the [Register Image Folder] button.
• The Select Image Folder dialog will display.
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■ Refreshing a Folder
Only image files that are added, copied or edited using ZoomBrowser EX will
display correctly in a folder that is part of a ZoomBrowser EX image folder. If you
move or copy image folders with the Windows Explorer program or edit images
with another application, the information contained in ZoomBrowser EX will not
be up-to-date. To update a folder, select it and click the [Refresh] button. This will
refresh the images in the selected folder and any subfolders within it.

 Note:
• For a more detailed explanation, please see the PDF manual, ZoomBrowser EX

Software User Guide (  9) or ZoomBrowser EX Help menu.
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4. In the next dialog, set the paper size and other settings and click
[Next].

5. In the last dialog, set the fine settings and click [Finish].
• The PhotoRecord window will display.
• If you wish to change the layout, set the printing settings in the PhotoRecord

window.

6. Click the PhotoRecord [Print] button.
• The Print dialog will display.

3. Select a print mode and click [Next].
• For the purposes of this example, please select [Artwork/Layout album].

Printing Images (PhotoRecord)

1. Select the image(s) you wish to print in the Browser Display Area.

2. Click the [Print] button and select [Layout] from the displayed
menu.
• The PhotoRecord printing utility will start and automatically display the

selected image(s) in a page layout.
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7. Click [OK] to start printing.

 Notes:
• When you select the “Artwork/Layout album” option, you can resize or

reposition images freely for printing. The other print modes allow you to do such
things as tile the images for printing or arrange them for printing on Canon
perforated paper. See the ZoomsBrowser EX Software User Guide (  9), a
PDF file, for a detailed explanation of the print modes.

• When you click thse [Print] button and select [Index] from the displayed menu,
the Print Index dialog will display. Sest the desired thumbnail size and paper
size, then click [Print] to start printing the index.
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Select a layout pattern 
for each page. Click 
the arrow ▼ to display 
a pop-up menu.

Select whether images 
are laid out 
automatically, manually 
or as an index.

Set the printing mode 
or paper size.

Change the page background or borders. Undo or restore the previous action.

Import images. Display the Print Dialog.

You can freely input 
page titles, image 
titles, or text.

You can drag 
images to change 
the layout.

Stop importing 
images.

Display Help.

Switch between 
control panel sizes 
with this.

Slide this left to 
shrink the image 
size and right to 
increase it.

PhotoRecord Window

Printing Images (PhotoRecord)



45

W
in

d
o

w
s

E

3. Select [1.Selection and Arrangement] and then click [Arrange].
• Determine the sequence to be used for merging the images.
• Operational instructions are displayed in the upper section of the window.

Merging Panoramic Images with PhotoStitch

To Merge Images Registered in ZoomBrowser EX
You can merge a series of overlapping images into a single, seamless panorama.
Use of the camcorder’s maximum wide angle setting is recommended when
recording images for merging into a panorama.

1. Select the images in the Browser Display Area.

2. Click the [Edit] menu and select [PhotoStitch] to start the
program.
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Merging Panoramic Images with PhotoStitch

4. Select [2.Merge] and then click [Start].

q Click [OK].

w Select the shooting technique and the focal length in the [Merge Settings]
screen.
• If you recorded images using the maximum wide angle setting, select

[50mm].
e Click [OK].



47

W
in

d
o

w
s

E

 Notes:
• You cannot use the Stitch Assist Mode.
• You can record images in a full circle and merge them into a 360-degree

panorama. Saving a 360-degree panorama in QuickTime VR makes it possible to
play back the image showing a full sweep around the circle. Note that you need
to have QuickTime installed on your computer to do this. If you do not already
have a copy of QuickTime, you can download it from the Apple Computer
Website.

• Please refer to the PhotoStitch Help menu for more details.

5. Select [3.Save] and then click [Save].
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2. Select the image file you want to add and then click [Open].
• The [Save to Camera Folder] window will appear on the display.

3. Select [Camera Model].
• Select the model name of the camcorder you are using.

4. Under [Image Size:] select [640×480], and then click [Save to
Camera Folder].
• [Adjust Height] and [Adjust Width] specify the standard for image

enlargement and reduction.

Adding Still Images from Your Computer to the Memory Card

You can copy still images from your computer to the memory card.

1. On the Camera window, click [UPLOAD].
• A window for selecting images to be added will appear on the display.
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 Notes:

• Image enlargement and reduction are not performed when both [Adjust Height]
and [Adjust Width] are deselected.

• When [Adjust Height] and [Adjust Width] are both selected, the aspect ratio of
the image (the ratio between the height and width of  the image) may change
when the image is resized.

• JPEG, Windows bitmap, TIFF, PhotoCD, and Windows Metafile format images
can be added to a memory card. Note, however, that an image becomes JPEG
format when it is stored on the memory card.

• You can also add images to a memory card by using drag and drop to move the
image from the browser area to the camera window.

• To add multiple images
Selecting multiple images in step 2 of the above procedure undims the [Save
subsequent images with the same settings] button on the [Save to Camera Folder]
window. Clicking this button makes it possible to add multiple images with a
single setting operation.
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 Notes:
• If you have uninstalled ZoomBrowser EX because of a corrupt database file or

other problem, please also delete the Database folder, which can be found within
the [C:\Program Files\Canon\ZoomBrowser EX] folder.

• PhotoRecord and PhotoStitch can be removed with the same procedures.

Uninstalling the Software

The following explanation uses the procedures for removing ZoomBrowser EX as
an example for removing other programs as well.

When uninstalling the DVC Storage Driver, refer to: Windows 98 (  15),
Windows Me (  19), Windows 2000 (  24), Windows XP (  30).

Uninstalling the ZoomBrowser EX

1. Click the Windows [Start] menu and select [Programs], [Canon
Utilities], [ZoomBrowser EX] and [ZoomBrowser EX Uninstall].
• The uninstall utility will start and remove ZoomBrowser EX.
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Troubleshooting

? Can’t download images or camcorder is not recognized when the
camcorder is connected via the USB interface.

➜ Computer doesn’t support the USB interface.
The USB interface is not supported for computers not in compliance with the
following requirements. Acquire the necessary system to use the USB interface.
Requirements
• Built-in USB interface on a system preinstalled with one of Windows 98/

Windows Me/Windows 2000/Windows XP.

➜ [From Canon Camera] is selected on the browser window.
Change the selection to [From Dcim].

➜ Camcorder is not correctly connected to the computer.
Read “Connecting the Camcorder to a Computer” (  32) and check the
connection.
Ensure that you are using the correct cable and that its connectors are in good
shape.

➜ If you are experiencing operational problems, detach the USB cable from
the camcorder and computer and terminate the connection. Restart the
computer and then reconnect the camcorder.

➜ DVC Storage Driver is not installed properly.
First uninstall the DVC Storage Driver and then reinstall it. To learn how to
uninstall it, see “Uninstalling the DVC Storage Driver”. To learn how to install
it, see “Installing the DVC Storage Driver”.

? Can’t install the DVC Storage Driver correctly.
First, Check the Following

➜ Does your computer comply with these requirements?
Does the system have a built-in USB port and did it come with Windows 98
(First or Second Edition), Windows Me, Windows 2000, or Windows XP
preinstalled?
(The USB interface is not supported for systems not complying with the above
conditions.)

➜ Is the camcorder correctly connected to the computer?
Please see “Connecting the Camcorder to a Computer” (  32).

➜ Are you using the AC power adapter to power the camcorder?

• If the Problem Is Not Mentioned Above
If the DVC Storage Driver is not correctly installed, it is possible that Windows
is not recognizing the DVC Storage Driver. Uninstall the DVC Storage Driver
according to the instructions before reinstalling it according to the instructions in
“Installing the DVC Storage Driver”.
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? ZoomBrowser EX displays a database file related error message
(E_Fail error, etc.)

➜ ZoomBrowser EX database file may be corrupted.
Please restore the database using the procedures described in the
“Troubleshooting” section of the PDF manual, ZoomBrowser EX Software
User Guide. You can display the ZoomBrowser Software User Guide from the
installer panel of the Canon Digital Video Solution Disk.

? Images in the [My Images] folder, or the [Image Library One]
folder are not displayed after I installed a new version of
ZoomBrowser EX.

➜ On the browser window, select [Refresh Online Registered Folders] from
the [View] menu.

Troubleshooting
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Macintosh  System Requirements

Computer Model:
Power Macintosh, PowerBook, iMac, iBook

OS:
Mac OS 8.6-9.2 (DVC Storage Driver is compatible up to Mac OS 10.1.)

CPU:
PowerPC

RAM:
20 MB or more of application memory

Interface:
USB: only systems equipped with genuine Apple-brand built-in USB interfaces

Free Hard Disk Space:
• Canon Utilities

- ImageBrowser 20 MB or more
- PhotoStitch 30 MB or more

Display:
800 × 600 pixels/256 colors or better, 1,024 × 768 pixels/32,000 colors or better
is recommended

 Notes:
• Proper operation is not guaranteed on a dual CPU PC or on a user-built PC.
• Proper operation is not guaranteed on any particular system, even if it meets the

requirements outlined above.
• A CD-ROM drive is required to install the software.
• Connect the camcorder directly to a USB port on the computer; not through a

hub. The connection may not operate correctly through a hub.
• The connection may not operate correctly if you are using other USB devices,

excluding USB mice or keyboards, at the same time. If this occurs, disconnect
the other devices from the computer and try reconnecting the camcorder.

• Do not connect two or more camcorders to the same computer via the USB
interface. The connections may not operate correctly.
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What Can Be Accomplished with the Software

This topic introduces the main features of the software programs contained on the
CD-ROMs.

■ DVC Storage Driver (  56)
• Driver software required for connecting the camcorder to your PC using a

USB cable. Makes it possible to use the camcorder as a memory card reader/
writer.

■ ImageBrowser (  59)
• Downloading still images recorded onto a memory card to your computer.
• Categorizing and Organizing Large Volumes of Images*.
• Searching and Organizing Images Chronologically*.
• Creating Mail Attachments from Images*.
• Laying Out and Printing Images.
• Programs for Printing Indexes.

■ PhotoStitch (  67)
• Merging Panoramic Images.

This instruction manual explains how to install the software, what you can do with
the main features and how to operate them. For more detailed operational instruc-
tions, refer to the ImageBrowser Software User Guide (PDF format) or the Help
menu of each software program. (*: For instructions on these features, refer to the
ImageBrowser Software User Guide.)

About the ImageBrowser Software User Guide
In order to view the ImageBrowser Software User Guide, it is required that Adobe
Acrobat Reader is installed on your computer. If it is not, install it according to
“How to install Adobe Acrobat Reader” below.

How to view the ImageBrowser Software User Guide
qPlace the Canon Digital Video Solution Disk in the CD-ROM drive.
wDouble-click the CD-ROM icon followed by the [Canon Digital Video Installer]

icon.
The installer panel will display.

e In the installer panel, click [Using the Software] and [ImageBrowser].
The guide will display.

• You can also display it by opening the [Readme] and [English] folders on the
CD-ROM and double-clicking [IB_guide.pdf].

How to install Adobe Acrobat Reader
qPlace the Canon Digital Video Solution Disk in the computer’s CD-ROM drive.
wOpen the [Readme], [Acrobat_English] folder.
eDouble-click the [Reader Installer] file to start the installer.
Follow the onscreen instructions to install Adobe Acrobat Reader.
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Installing from the Canon DIGITAL VIDEO SOLUTION DISK

1. Close any programs that are running.

2. Set the Canon DIGITAL VIDEO SOLUTION DISK in the compu-
ter’s CD-ROM drive.

3. Double-click the CD-ROM icon and the [Canon Digital Video
Installer] icon.
• The installer panel will display.

4. Click [Digital Video Software Installation].

6. After the installation is complete, restart the computer as prompted.

If you are using Mac OS 8.6: Next, install the DVC Storage Driver. Do not
remove the CD-ROM from the computer’s drive.

5. Click the [Install] button.
• The installation will start.
• Follow the onscreen messages to proceed with the installation.

Installer Panel
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Installing the DVC Storage Driver

This driver is designed for use with Mac OS8.6. For Mac OS 9 or higher, you
should use the standard USB driver software that comes with the OS, without
installing this driver.

1. Connect the camcorder to an AC outlet.

2. Attach the supplied USB cable to the computer’s USB port and the
camcorder’s USB terminal. (  57)

3. Set the camcorder to CARD PLAY(VCR) mode.

4. Double-click the CD-ROM drive icon.

5. In [DVC Storage Driver], open the folder with the name that
matches the name of your camcorder.

6. Use drag and drop to move the two files inside the folder into the
[Extensions] folder, which is located inside the [System Folder]
folder on your hard disk.
• The names of these files are [DV×-USB Storage Driver] and [DV×-USB

Storage Shim] (× stands for either ‘A’ or ‘B’).

7. Restart your computer.
• The [CANON_DV] icon or the coressponding drive icon will be displayed

on your desktop.
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Connecting the Camcorder to a Computer

Connecting to a USB Port

Connection Precautions
• Make sure the camcorder is being powered using the compact power adapter

before connecting it to a computer.
• Be sure to install the DIGITAL VIDEO SOLUTION DISK before you connect

the camcorder to the computer.
• Connect the camcorder directly to a USB port on the computer; not through a

hub. The connection may not operate correctly through a hub.
• The connection may not operate correctly if you are using other USB devices,

excluding USB mice or keyboards, at the same time. If this occurs, disconnect
the other devices from the computer and try reconnecting the camcorder.

• Do not connect two or more camcorders to the same computer via the USB
interface. The connections may not operate correctly.

• Never allow the computer to go into standby (sleep) mode while a camcorder
is connected via the USB interface. If it does happen, never disconnect the
USB cable. Try to awaken the computer with the camcorder in the con-
nected state. Some computers will not awaken properly if you disconnect the
camcorder while they are in standby mode. Please refer to your computer
manual for instructions regarding its standby mode.

1. Attach the supplied USB cable to the computer’s USB port and the
camcorder’s USB Terminal.
• You do not need to turn off the computer for this procedure.
• Refer to your computer manual for the location of the computer’s USB

ports.
• See your camcorder instruction manual for connecting instructions.

USB Cable

Camcorder End Computer End

USB Terminal
on the Camcorder

USB Port on 
the Computer
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Disconnecting the camcorder from the computer

1. On the desktop, drag [Canon_DV] or the corresponding drive icon
into the Trash.

2. Turn off the camcorder and detach the USB cable.

● To detach the cable, always hold the connector by its sides to pull it out.
● Turn off the camcorder before inserting/removing the memory card.

Connecting the Camcorder to a Computer
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Cautions:
• Make sure you observe the following precautions whenever an image is being

read from or written to the memory card (which is indicated when the
camcorder’s card access indicator is flashing).  Failure to do so can cause
memory card data to become corrupted.
– Never remove the memory card or detach the USB cable.
– Never turn off the camcorder or computer.

• Do not format memory cards on a computer.

1. Insert the memory card to the camcorder.

2. Connect the camcorder to an AC outlet.

3. Attach the supplied USB cable to the computer’s USB port and the
camcorder’s USB terminal. (  57)

4. Set the camcorder to CARD PLAY(VCR) mode.
• The [CANON_DV] icon or the corresponding drive icon will appear on the

display.

5. Double-click the [Canon ImageBrowser] icon on the desktop.
• ImageBrowser will start.
• If the icon does not appear on the desktop, double-click the folder in which

you installed the program, followed by the [Canon Utilities] and
[ImageBrowser] folders and the [ImageBrowser] file.

Downloading Images to a Computer (ImageBrowser)

Explorer View Section

6. Double-click the [DCIM] folder in the Explorer View Section.
• No image will be imported if you click [Canon Camera].  Make sure you

select [DCIM].
• The images from the memory card will display as thumbnails in the Camera

window (  60).

Canon ImageBrowser Icon
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Downloading Images to a Computer (ImageBrowser)

 Notes:
About the other buttons
• [SELECT]: You can select all of the images or deselect images, etc.

[ROTATE]: You can rotate (90 degrees counterclockwise/90 degrees clockwise/
180 degrees) the images.
[IMAGE INFO]: You can confirm the number of pixels or the file size of the
selected image.

• You can not use the [SETUP OPTIONS] and [CONNECT CAMERA] functions.
• You cannot use the [SLIDE] function (to select images for inclusion in a

slideshow) of the [SLIDE/DPOF] button.

Thumbnail
The image is displayed 
reduced in size.

Delete Button
Delete selected 
images.

Download Button
Load the selected 
images onto the 
computer (      62).

Upload Button
Copy images from the 
computer onto the 
memory card (      69).

Print Layout Button
Select the printing 
method: Layout or Index.

The ImageBrowser Camera Window
When a connection is opened to a memory card in a camcorder, the card’s images
display as thumbnails in the Camera window.
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Understanding the Browser Window
This section describes the various parts of the Browser Window display.

Image Name
This is where 
the file name 
of each 
individual
image is 
displayed.

Explorer View Section
Displays the disks and folders 
that you can use on your 
computer.
If you click the disclosure triangle 
on the left edge of the display, 
you can switch between 
collapsing and expanding the 
contents of that folder.

You can drag this line to 
change the position of the 
boundary between the 
Explorer View Section and 
the Browser Area.

You can drag this part 
of the frame to change 
the size of the Browser 
Window.

Control Panel
This area contains 
buttons that allow you 
to perform a variety of 
functions.

Browser Area
This is the area where thumbnails of 
images in the selected folder are 
displayed.



62

Downloading and Saving Images from the Camcorder

1. Select [Macintosh HD] in the Explorer View Section.

Explorer View Section

2. Create a new folder for saving images from the memory card in the
camcorder.
• Click the [File] menu and select [New Folder]. A folder with the name

“Untitled” will be created. Click it to change the folder name as you wish.
In this example, we will input “Travel.”

3. In the Explorer View Section, click the newly created folder.

Downloading Images to a Computer (ImageBrowser)
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4. Select images in the Camera window and click the [Download]
button.
• Click a thumbnail to select it or press [Shift] and click to select multiple

thumbnails. The color of the frame(s) around the thumbnail(s) you selected
will change to blue.

• Downloaded images are saved to the computer and appear in the Browser
area.

Thumbnail

Explorer View Section

Browser area
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 Notes:
• Double-clicking an image on the camera window imports the image to the

computer.
• You can also download images to the computer by dragging them from the

Camera window and dropping them on the Browser area or the Explorer View
Section.

• You can select multiple images by holding down [Shift] or [Option] + [Shift]
while clicking.

• To disconnect the camcorder, click the close box  at the upper left of the
Camera window. The Camera window will close.

Downloading Images to a Computer (ImageBrowser)
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Printing Images (ImageBrowser)

1. Select the image(s) you wish to print in the Browser Window.

2. Click the [Print] button and select [Layout Printing] from the
displayed menu.

Layout Options Window

Print Window

3. In the Layout Options window, select the desired layout and click
the [Next] button.
• Select the [Custom layout printing] option for the purposes of this example.

4. In the next window, select a paper size and click the [OK] button.
• The Layout Options window will close and the Print window will open,

allowing you to change the layout and printing settings.
• The settings available in Step 4 will vary according to the type of layout

selected in Step 3.
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Change the Image 
Size
Drag the border to 
resize the image. 

Change the default 
number of images 
printed per page. 

Rotate the selected 
image.

Reset the layout.

Edit the Page Title
Open the [Edit] 
menu and select 
[Edit Header].

Change the Layout
Drag the images to 
change the layout.

Displays the Layout 
Options window.

Display the Print 
dialog.

Add Text
Open the [Edit] 
menu and select 
[Add Text].

Add Captions to 
Images
Click the image and 
then the [Edit] menu 
and select [Edit 
Caption].

5. Click the [Print] button in the Print window.
• The Print dialog will display.

6. Click [OK] to start printing.

 Note:
• The Custom Layout printing option in the Layout Options window allows you to

freely change the size and position of the images for printing. The other options
allow you to print an index or print onto Canon perforated paper. For more
details on the Layout Options window, please see the PDF manual,
ImageBrowser Software Guide (  54).

Print Window
When the Custom layout printing option is selected in the Layout Options window,
you can freely change the size and position of the images for printing.

Printing Images (ImageBrowser)
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Merging Panoramic Images with PhotoStitch

To Merge Images Registered in ImageBrowser
You can merge a series of overlapping images into a single, seamless panorama.
• Use of the camcorder’s maximum wide angle setting is recommended when

recording images for merging into a panorama.

1. Select the images in the Browser Window.

2. Click the [Edit] menu and select [PhotoStitch] to start the
program.

3. Select [1.Selection and Arrangement] and then click [Arrange].
• Determine the sequence to be used for merging the images.
• Operational instructions are displayed in the upper section of the window.
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4. Select [2.Merge] and then click [Start].

q Click [OK].

w Select the shooting technique setting and the focal length in the [Merge
Settings] screen.
• If you recorded images using the maximum wide angle setting, select

[50mm].
e Click [OK].

Merging Panoramic Images with PhotoStitch
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5. Select [3.Save] and then click [Save...].

 Notes:
• You cannot use the Stitch Assist Mode.
• You can record images in a full circle and merge them into a 360-degree pano-

rama. Saving a 360-degree panorama in QuickTime VR makes it possible to play
back the image showing a full sweep around the circle. Note that you need to
have QuickTime installed on your computer to do this. If you do not already
have a copy of QuickTime, you can download it from the Apple Computer
Website.

• Please refer to the PhotoStitch Help menu for more details.
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Adding Still Images from Your Computer to the Memory Card

You can copy still images from your computer to the memory card.

1. On the camera window, click [UPLOAD].
• A window for selecting images to be added will appear on the display.

2. Select the image file you want to add and then click [Open].
• The [Save to Camera] window will appear on the display.

3. Select [Camera model].
• Select the model name of the camcorder you are using.

4. Select [Large] and then click [Save to Camera].
• [Adjust Height] and [Adjust Width] specify the standard for image enlarge-

ment and reduction.
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 Notes:
• Image enlargement and reduction are not performed when both [Adjust Height]

and [Adjust Width] are deselected.
• When [Adjust Height] and [Adjust Width] are both selected, the aspect ratio of

the image (the ratio between the height and width of  the image) may change
when the image is resized.

• JPEG, TIFF, PICT, and Windows bitmap format images can be added to a
memory card. Note, however, that an image becomes JPEG format when it is
stored on the memory card.

• You can also add images to a memory card by using drag and drop to move the
image from the browser area to the Camera window.

• To add multiple images
Selecting multiple images in step 2 of the above procedure undims the [Save
subsequent images with the same settings] button on the [Save to Camera]
window. Clicking this button makes it possible to add multiple images with a
single setting operation.



72

Uninstalling the Software

Uninstalling Application Programs
Move the program’s folder into the Trash to uninstall programs such as
ImageBrowser and PhotoStitch.

 Note:
• If the program folders contain subfolders into which images have been saved, be

careful not to accidentally delete those subfolders.
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Troubleshooting

This topic explains some of the causes for and solutions to problems with the
software.

? Can’t download images, camcorder is not recognized when the
camcorder is connected via the USB interface.

➜ Computer doesn’t support the USB interface.
The USB interface is not supported for computers not in compliance with the
following requirements. Acquire the necessary system to use the USB interface.
Requirements
• Genuine Apple Computer brand computer with a built-in USB interface.

➜ [Canon Camera] is selected on the Explorer view section.
Change the selection to [DCIM].

➜ There is no memory card in the camcorder.
Insert a memory card into the camcorder.

➜ Camcorder is not correctly connected to the computer.
Read “Connecting the Camcorder to a Computer” (  57) and check the
connection.
Ensure that you are using the correct cable and that its connectors are in good
shape.

➜ If you are experiencing operational problems, detach the USB cable from
the camcorder and computer and terminate the connection. Restart the
computer and then reconnect the camcorder.

➜ If you are running Mac OS8.6, check to make sure the following two files
are contained in the [Extensions] folder, which is located in the [System
Folder].
• DV×-USB Storage Driver
• DV×-USB Storage Shim

‘×’ stands for either ‘A’ or ‘B’.


